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ABSOLUTE FIDELITY NEWSLETTER 

This year, 2012, is the Year of the Dragon and year 4710 in the Chinese Calendar. It also marks 

the 10th Anniversary of Genesis Advanced Technologies.It seems like just yesterday that we started 

– I guess I must still be having fun. 

The relationship between stimuli and the perception is proportional to the logarithm – the Weber-

Fechner Law. Human beings cannot perceive a change if it is small in relation to what it already is. 

Editor‟s Say 

The problem with computer-based music servers is that 

computer technology moves so fast that before you‟ve 

finished building one, it‟s already obsolete. In Oct 2010, we 

published the 5th version of the Absolute Fidelity® music 

server. This was the server used at RMAF 2010 and CES 

2011, and also by members of the Pacific Northwest Audio 

Society. Unfortunately, the motherboard, processor, and 

memory we used to build that server are all already 

obsolete.  

This 6th version server is based on a Toshiba Laptop for a 

number of reasons. First, primarily for convenience, I 

needed one to travel with and to demo at dealer events, 

Take images – an increase in resolution of a low 

resolution picture is more easily perceived than 

the same increase to a higher resolution picture. 

Hence, as we continue to improve our products, 

the next improvement has to be much larger 

than the one before. Therein lies the challenge 

for the next ten years! 

I hope that you stay with us for the journey as we 

grow – the best is yet to be! 

Cheers! 
Gary   

 
The new laptop-based Absolute Fidelity Music Server 

with the box from the SSD that was installed. 
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 Building Yet Another Absolute Fidelity® Music Server 
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Absolute Fidelity 

and packing the server, external hard-drive, 

screen, keyboard, mouse, three power 

supplies, etc. was becoming tiresome. 

Second, with the new async USB DACs, I was 

becoming less concerned with jitter and 

more concerned with grounding and 

isolation issues which   I   figured could be 

managed. Third, the new Intel Sandy Bridge 

processors had features that sounded ideal 

for what I wanted in a music server. 

Objectives 

To build a reference quality music server for 

playback of high-resolution and Redbook 

digital music files.  With USB becoming the 

“standard” for attaching DACs, Firewire was 

no longer needed – which made hunting for 

a suitable laptop a LOT easier. 

No consideration is given to things like 

Internet security, anti-virus protection, etc. 

Hence, the result of this build is not going to 

be a general purpose computer that can also 

be used as a music server. This is a laptop 

computer that is specifically built to become 

a music server. 

Please note that Genesis is not in the 

business of building or consulting on music 

servers, and the instructions given here are 

for information only. You may need to get a 

techy friend to read the instructions, and you 

may need to buy him/her dinner (or a lot of 

beers) to get help completing this project. 

Choosing the Laptop 

I knew that I wanted a laptop with the new 

Sandy Bridge processor, but which one? This 

latest architecture, released in Jan 2011, 

attracted me for a couple of reasons – it 

featured 17% more CPU performance clock-

for-clock than the Lynnfield processor used 

in the last build, and better CPU-Turbo 

management. 

Why Turbo? We don‟t need more speed – but what 

it does offer is a better way to manage slow-

down. Why? With the Pentium dual core only 

Thermal Design Power at only 35W, clocking it 

DOWN (because music serving doesn‟t require 

much power) means that we can passively cool, 

and still perform because it‟s 17% faster. 

It happened that there was a sale on a very nice 

Toshiba C655-S5339 with the Pentium B950 

processor (35W TDP, 2.1GHz) and Windows 7 

Professional that seemed to have the right 

features and size, and was the right price ($400). 

So, I bought three. 

Also, since the laptop had an ordinary internal 

hard disk drive, I wanted to replace it with a solid 

state drive. I added a 240GB SSD to go (which cost 

almost as much as the laptop!!). 

Initial Set-up 

When it arrives, turn it on. You‟ll answer a few 

questions about yourself, and the laptop sets 

itself up with Windows 7. 

The problem is that most laptops these days don‟t 

come with Windows recovery disks, so the first 

thing you will want to do is to create recovery 

disks – just in case you make a big mistake and 

need to restore the laptop to its „virgin‟ state. As 

the laptop comes with a DVD-ROM writer, this is 

quite easily done (instructions are supplied with 

the laptop).  

To do this, use the Windows 7 Backup utility: 

1) Click the round Windows symbol  – this 

is the Start button. 

2) You will see a list of commands, click 

[Control Panel] on the list on the right. 

3) A new window will pop-up, this is the 

Windows Control Panel. 
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4) On the upper right, you will see [View 

by: Category]. Click the word Category 

and you will get a drop-down list. Click 

[Large icons]. 

5) Click [Backup and Restore]. 

6) A new menu will open and on the left 

click the option [Create a system image]. 

In the rest of this paper, the six steps above 

will be denoted as: Start > Control Panel > 
View by: > Large icons > Backup and Restore > 

Create a system image. 

Follow the instructions to make a set of DVDs 

that will be an image of your hard-disk, and 

also a Windows Recovery Disk. You will use 

these discs in case you have to recover the 

laptop to “as new” condition. The Windows 

Recovery Disk will be used to migrate to the 

SSD later, so don‟t forget to create it now. 

Next, you will want to update Windows. Hook it 

up to the Internet (preferably using an Ethernet 

cable) and then Start > Control Panel > Update  

You may have to do this several times to install 

all the important upgrades, and then install 

optional upgrades which may generate more 

important upgrades. 

With this particular Toshiba Laptop, Microsoft 

Security Essentials and .Net Framework are not 

installed. So, go to the Microsoft website and 

download and install these two. For the .net 

Framework, don‟t just install the Client Services 

– install the full set-up. 

After setting up Windows, you will need to go 

to the Internet to download the software that 

you will be using to turn the laptop into a 

music server. 

Foobar – the Music Player 

The software we will use for this is a freeware 

player called Foobar. Go to the official Foobar 

website at www.foobar2000.org and download 

the latest version. Next, download the following 

official components at the [Components] tab: 

 Album list panel – needed for Columns UI 

 ASIO support – bit-transparent playback with 
some DACs 

 Columns UI – a highly configurable user interface 
for Foobar  

 HDCD Decoder - for decoding HDCD discs, 
resulting in a 20bit file 

 Masstagger – for tagging your FLAC files with the 
metadata of the music such as title,composer, 
artist, genre, etc. 

 Quicktagger – same as above except that it does 
one file at a time 

 WASAPI output support – seems to be best for 
Windows 7 

Other components will have to be searched for and 

downloaded from the respective authors websites. 

They can all be found easily by searching for the 

filename in bold. 

 Album Art Panel – foo_uie_albumart. Displays 
album art as part of Columns UI – not necessary, 
but adds to the visual attraction. 

 Windows 7 integration – foo_w7shell. Integrates 
Windows7 visualisation such as aero-peek, etc. 
We will eventually disable this, but download it 
anyway. 

 Peakmeter Spectrum Visualisation – 
foo_uie_vis_peakmeter_spectrum. While this is 
CPU intensive, it is extremely useful as a gauge 
of the quality of the file you are playing.  

 iPhone/iPad Touch Remote Support – 
foo_touchremote. This uses an Apple iPad to 
control Foobar. In order for this to work, also 
download and install Bonjour Print Services for 
Windows 7 from the Apple website.  

 SoX Resampler – one of the advantages of using 
a music server is that you can preprocess the 
digital files using the power of the computer. 
One of the best free sample rate converters is the 
SoX resampler which can be run as a real-time 
Foobar plug-in or as a batch file to pre-convert 
the files. The plug-in also allows you to try 
different sample rates to determine which sound 
best with the DAC you are using. 

Other Useful Software 

A few other pieces of free software are easily found 

using search engines on the Internet. 

http://www.foobar2000.org/
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  dpc latency checker – this is a useful tool to 

check that you have done a good job with the 
server optimization 

 CPUID hw monitor – makes sure that your 
heat/CPU parameters are within safe limits 

 Defraggler – will be used later to de-
fragment and compress the hard disk 

 EASEUS Partition Master – will be used later 
to reduce the size of the partition so that it 
will fit into the SSD 

 

After you have downloaded the software, 

unplug the network cable, and use Security 

Essentials to scan the computer to make sure 

that you haven‟t inadvertently picked up a virus 

in the meantime. 

Disabling Power Saving 

Once the virus scan completes, disable the 

power savings mode on the laptop. Usually, to 

extend battery life, a rather aggressive power 

saving scheme is implemented on laptops. 

However, while good for battery life, power 

saving is bad for music, so disable it by: Start > 

Control Panel > View by: > Large icons > Power 

Options > High Performance 

Next, from the menu list on the left, click 

[Choose what closing the lid does] and on the 

menu that comes up, choose [Do Nothing] for 

[When I close the lid] and [Shut Down] for 

[When I press the power button]. 

Optimizing Windows 

We will set up and tune Windows 7 so that this 

is just a dedicated music server. All services 

that do not contribute to good sound will be 

disabled. We will also prepare Windows to be 

migrated to an SSD and optimize the BIOS to 

run cool. You will have to restart the computer 

several times in the process, and it may take a 

bit of time so leave the laptop plugged into a 

power source. 

Disable Redundant Features 

At Start > Control Panel > System > Advanced 

System Settings > Performance [Settings] you 

will get to a menu with three tabs across the 

top. 

 Under the Visual Effects tab, click the 

radio button for Adjust for Best 

Performance. 

 Under the Advanced tab, click the 

[Change…] button under Virtual Memory. 

Another panel will pop up. Uncheck the 

option Automatically manage paging file 

size for all drives. Then you can click 

the radio button for No paging file. 

Click the [OK] buttons until you get back to the 

control panel. Restart the computer to activate 

these settings. 

From the Start > Control Panel > Programs and 

Features > Turn Windows Features on or off turn 

off the following by unchecking the following 

check boxes: 

 

Located as a sub-menu under the Control Panel, 

un-used Windows features should be turned off. 
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 Games 
 Media Features 
 Print and Document Services 
 Remote Differential Compression 
 Tablet PC Components 
 Windows Gadget Platform 
 Windows Search 
 XPS Services 
 XPS Viewer 

Disable System Services 

These next steps could give you a lot of grief, 

so proceed with care!! From Start > All 

Programs > Accessories >Run a screen (next 

page) will pop up, type in services.msc, hit 

enter and you will get the screen above. 

Disable the following services by double-

clicking on the service name and selecting 

Disable as the Start-up Type on the screen 

that pops up. 

 Background Intelligent Transfer 
 BitLocker Drive Encryption 
 Certificate Propogation 
 Diagnostic Policy/Service/System/Host 
 Distributed Link Tracking Client 
 DNS Client 
 Encrypting File System 
 Extensible Authentication Protocol 
 Function Discovery Provider/Resource 
 Google Update 
 Health Key and Certificate Management 
 Internet Connection Sharing 
 IP Helper 
 Print Spooler 
 Quality Windows Audio Video Experience 
 Secure Socket Tunneling Protocol 
 Themes 

Turning off these next few services will make 

your computer very vulnerable to computer 

viruses, Trojans and other forms of attacks. Do 

not do this if your music server is to be 

permanently connected to the Internet.  

 Base Filtering Engine 
 Event Log 
 Microsoft Antimalware Service 
 Microsoft Network Inspection 
 Security Account Manager 
 Security Center 
 Windows Defender  
 Windows Firewall  
 Windows Updates 

At this point, I also like to disable User Account 

Control. Start > Control Panel > System > User 

Accounts > Change User Account Control Settings 

A new window will pop-up with a slider bar. 

Slide it all the way down to [Never Notify] and 

confirm. 

Installing a Solid State Drive 

To reduce the possibility of electrical jitter that 

could be caused by head movement in the 

internal hard drive, we replace it with a solid 

state drive (SSD). The problem is that this can be 

difficult because the included drive is bigger 

than the SSD drive we are using to replace it, 

and the Windows imaging tool does not allow 

recovery to a smaller drive. 

The first step would be to clear space and 

compact the size of the drive so that it will fit. 

As Microsoft reserves unmovable clusters, we 

will have to first remove these. 

1) Disable Hibernation (we won‟t be using it 

anyway). Press the [Windows] key (lower 

left) on the keyboard, and while it is 

pressed, press the [R] key. The Run 

dialog will appear. Type in [cmd] and hit 

  

The Windows key is usually 

on the bottom left of the 

keyboard. 
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[Enter]. The DOS prompt will appear (a 

black screen) for you to key in 

[powercfg.exe -h off] and hit [Enter]. 

Next, type in [exit] and hit [Enter]. 

The DOS screen disappears. 

2) Disable System Restore. Start > Control 

Panel > System > System Protection The 

System Protection menu will appear 

with a list of drives. Click the [C:] drive 

and then click [Configure…]. A new 

menu will appear, and click the radio 

button that says [Turn off system 

protection]. 

This will free up the reserved hibernation file, 

and release Windows reserved space for 

restore points. With a new computer, you 

probably will not need to delete the old 

restore points. Only if necessary (you have 

been using the laptop for some time already) 

use Disc Cleanup to delete the old restore 

points. Restart the computer. 

Once the system restarts, compact the disc 

using the previously downloaded defraggler. 

Then, run Partition Master to reduce the size 

of the C: partition to at least 10% smaller than 

the SSD you are installing. You may have to 

restart the computer a couple of times. 

Once this completes, make another new set of 

System Image DVD-ROMs. This new set will be 

used to install the SSD, and also will be used 

as a back-up to restore the laptop to this 

point. 

Turn the laptop over, remove the hard-drive 

and replace it with the SSD. 

Optimizing the BIOS 

This is a good time to make sure that the 

settings in the BIOS are optimized for music 

playback. Turn the laptop on and when the BIOS 

post screen shows, Hit the [F2] key and it will 

take you to the BIOS Setup Utility main system 

configuration screen. Hit the right arrow key 

twice to get to [Power Management]. Then use the 

down arrow key to get to [Dynamic CPU Frequency 

Mode] and set it to [Always Low]. 

Next, go down to [SATA Interface Setting] and 

choose [Performance]. 

Hit the right arrow key on the keyboard to get to 

the [Advanced] tab. Hit the down arrow key to 

[System Configuration] and hit [Enter]. Confirm 

that [SATA Controller Mode] is [AHCI] (it should 

be by default). If it is not, set it to [AHCI]. 

Eject the DVD-ROM drive and insert the 

Windows Recovery Disk you made, and then 

Exit, Saving Changes. Once it boots up, use the 

set of System Image DVD-ROMs that you just 

made to restore the system to the newly-

installed SSD. 

When it completes, take out the Windows 

Recovery Disc and restart the computer.  

The system should now reside on the SSD, and 

be exactly the same as before you installed the 

SSD. 

Next, use Partition Master again to resize the C: 

drive to about 30GB (this should be more than 

enough for Windows and software), and create a 

new partition M: out of the remaining space for 

use as music storage. 

Configure Foobar 

In File > Preferences > Playback > Replay Gain – 

set Source Mode and Processing to none. Then, still 

in the Preferences menu, under Output > Device 

set Foobar to play using the WASAPI driver for 

your DAC. 



That‟s it! The Absolute Fidelity Music Server. 

For an experienced PC user, it should take no 

more than an afternoon to complete – 

including replacing the hard-drive, set-up and 

tuning. 

Additional Software Components 

We use another four pieces of software in our 

server to enhance the experience: 

 ExactAudioCopy (free) or dBpoweramp ($38) 
– for ripping CDs to the music server. The 
latest versions of of both include a link to 
the AccurateRip database – for assurance 
that your rips are being accurately done. 

 DVD-A Explorer (free) or DVD Audio 
Extractor ($32.50) – for ripping DVD-A‟s to 
the music server. Unfortunately, of the 17 
DVD-A‟s I own, only one of them turned out 
to be a true high-resolution recording. 
Nevertheless, if you have a lot of DVD-A‟s it 
is worth buying DVD Audio Extractor. 

 FLAC for Windows – for converting existing 
WAV files to FLAC. We did extensive A-B 
comparisons between WAV and FLAC, and 
couldn‟t tell the difference. Hence, I now 
convert all my WAV files to FLAC – not to 
save disk space since hard drives are so 
cheap these days, but so that I can 
associate album art and metadata (artist, 
album, genre, composer, title, etc.) 
information to the music that I‟m listening 
to. 

 FLAC will require a windows component – 
MSCOMCTL.OCX to be loaded and 
registered. Use Google search for more 
information on where to download and how 
to install this. 

 Album Art Downloader – a useful program 
for automatically searching for and 
downloading album cover artwork of the 
CDs in your music server. They have to be 
properly tagged with artist and album 
information before it will  
work. 

Setting-up for Remote Control 

An iPad can be used to remotely control the 

server. If you haven‟t already done it, 

download the foo_touchremote DACP server 

from wintense.com. The will be four .dll files 

to install on your Foobar component directory. 

You will also need to make sure that you have 

the complete .NET Framework installed. 

Next, an undocumented Windows 7 feature 

makes it possible to set up a virtual wifi 

hotspot using the internal wireless adapter of 

the laptop. 

To do this, get to the command prompt 

([Windows] [R] key in ‘cmd’ and press 

[Enter]) and issue these two commands: 

 Netsh wlan set hostednetwork 
mode=allow ssid=[chosenssidname] 
key=[10digithex] keyusage=persistent 

 Netsh wlan start hostednetwork 

Replace [chosenssidname] and [10digithex] 

with your preferred SSID and security key. 

You‟ll have to do this each time you restart 

the machine. However, a batch file can be 

written to do this automatically – buy your 

best techy friend a couple of beers and he 

may be able to do it for you. 

On your iPad, you will need to go to the 

iTunes appstore and download the Apple 

Remote app. After you set up the virtual 

hotspot as above, configure the iPad to use 

the hotspot.  

In Foobar, File > Preferences > Media Library 

> TouchRemote DACP Server click the button 

[Add a new device] - and a window will pop up 

asking for a 4-digit code. On the iPad, fire up 

Remote, and choose [Add an iTunes Library]. 

It will give you a 4-digit code to enter on the 

server, and you will be “paired”. 

Finally, to make Foobar look “pretty”, the 

ColumnsUI layout I use is available here: 

http://www.genesisloudspeakers.com/downloads/

CUI_Layout.fcl 

Import it with File > Preferences > Display > 

ColumnsUI > Main > [Import] 

That‟s it – the 6th generation of the Genesis 

Absolute Fidelity Music Server. Run on 

batteries for best sound quality, and have fun! 
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Understanding Loudspeaker Coupling/Decoupling 

A question that I get asked a lot is “what do I 

have to do to properly stabilize a pair of 

loudspeakers?” Floor-standing speakers are 

sometimes supplied with feet and spikes already 

installed, or they have inserts to allow spikes to 

be screwed into the cabinet. How effective are 

spikes? With your stand-mounted monitor 

(bookshelf) loudspeakers, what stands do I use? 

What do I use to couple/decouple the speaker to 

the stand? 

Definitions 

Couple – to “make as one” as in coupling a 

loudspeaker to a loudspeaker stand makes the 

stand and the loudspeaker as one. Coupling the 

loudspeaker to the floor makes like the speaker 

is a part of the floor, and coupling the 

loudspeaker to the loudspeaker stand makes 

the stand a part of the loudspeaker – like it has 

suddenly grown feet. 

The opposite is to de-couple – where there is 

absolutely no relationship. Using an anti-gravity 

generator to float the loudspeaker is an 

example of de-coupling. Even magnetic 

levitation has some degree of coupling. 

Absolute de-coupling is impossible using 

current technology. 

So, for the real-world purposes of 

understanding loudspeaker coupling/ 

decoupling, there is no perfect coupler and 

there is no perfect de-coupler. 

The Musical Context 

We must consider that the context of our 

discussion to be that the loudspeaker is playing 

music, and not sine waves. Sine waves are 

symmetric. Music is almost never symmetric. 

Music is transient and chaotic. 

For example, common sense tells us that a 

plucked guitar string, a bass drum hit, a struck 

piano key all have a much larger initial positive-

going wave than the negative wave. Looking at the 

waveform of a piano note, it is easy to see that 

there is more energy in the positive-going wave. 

As the note decays, it will get more and more 

symmetric. 

Once we understand this about music, we can 

design proper loudspeaker coupling/ decoupling. 

This fact is also important to driver design, 

crossover design, amplifier design, power supply 

design, and cable design for music reproduction, 

but at this time we won‟t go there. There is net 

forward energy from the loudspeaker drivers, and 

there will be net backward energy in the 

loudspeaker cabinet that has to be managed. 

Coupling by Spiking Loudspeakers 

Spikes are couplers and will couple the 

loudspeaker to the earth – or are they? Most of 

what you read will tell you that a spike is a coupler 
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Part of a musical note 



– and common sense will tell you that it is, until 

you examine it in much greater detail 

Considering the forces vertically, the spike is a 

coupler. Due to the tiny contact patch, it is a 

low impedance path to ground for all 

frequencies of vibration. Considerations include 

the size of the contact patch at the point of the 

spike (how sharp is the spike), the material the 

spike is made of (whether the spike deforms), 

and the material the spike sits on (whether it 

dents). 

If the spike deforms, and the deformation is 

elastic, there may be a resonant frequency at 

which the spike will “bounce”. In general, we 

would consider the spike an excellent coupler 

in the vertical plane. 

However, what happens when we look at the 

spike with forces in the horizontal plane? Then, 

whether the spike is a coupler or a de-coupler 

takes a whole different complexion. 

If, like skates on ice, the spike is very hard, the 

surface on which it sits is very hard, and there 

will be low friction, then spike is a decoupler. 

Depending on the weight of the loudspeaker 

and the friction of the surface the spike sits on, 

a sufficiently large sideway force will cause the 

spike to slide around on the surface. 

If the spike can deform the surface in any way, 

there will be a whole host of new things to 

consider. For example, if the surface is hard 

stone, and the spike is steel, a large enough 

horizontal force could cause the spike to just 

scrape around on the surface, and you might get 

a sound like fingernails on a chalkboard 

(blackboard). 

If the surface is wood, and the spike makes a hole 

and nails the loudspeaker to the wood, then the 

wood couples to the loudspeaker, and you might  

get a warm, woody sound that some audiophiles 

will find attractive.  

Now that we understand that the spike is a 

coupler in the vertical plane and could be a 

decoupler in the horizontal, we need to consider 

the forces that the spike will meet. The next 

consideration is simple vector mechanics that we 

all learned in High School. 

Examining the dynamic forces  

generated by the movement of  

the driver cone (blue arrow) in a  

loudspeaker, there will be zero  

vertical forces since the cone is  

almost directly above the front  

spike, but the horizontal force  

will equal the force generated  

by the driver assuming always  

that the spike is tightly coupled  

to the speaker cabinet by  

screwing it in or glueing. 

The rear spike, on the other hand will have both a 

vertical element as well as a horizontal element. 

(The red vector.) We mustn‟t forget that there are 

also static forces on the spikes due to the mass 

of the loudspeaker and gravity. 

Since the point of force and the two spikes are 

rigidly coupled by the loudspeaker cabinet, the 

forces on the two spikes will also be related. 

Looking at the rear spike, the combination of the 

horizontal and vertical forces, and friction will 

result in a third force (green vector below). 

 
Spike is vertically 

coupled 

 
…but horizontally 

decoupled 
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To illustrate this third force, if you push the 

top of a spiked loudspeaker, and if there is 

sufficient static force (weight) on the spikes 

and if there is sufficient friction, the 

loudspeaker will start to tilt backwards on 

the rear spike. If you pull the top of speaker 

towards the front, the speaker will tilt 

forwards on the front spike. On a hard, 

slippery low-friction surface, pulling or 

pushing the top of the loudspeaker, even 

when it is on spikes, will cause the 

loudspeaker to slide. 

Thus, although we mentioned earlier that 

there is zero vertical force on the front spike 

generated by the horizontal driver forces, 

the front spike‟s tightly coupled relationship 

to the rear spike plus friction at the rear 

spike creates some vertical forces. You will 

also find that due to the different vector 

forces, it is easier to pull the front of the 

speaker to tilt it forwards than it is to push 

the front of the speaker to tilt it backwards.  

Hence, the spiked speaker will react 

asymmetrically to forces generated at the 

top of the speaker (usually the midrange – 

as the tweeter is usually too small and light 

to generate significant forces at the foot). 

With sufficient forces at a midrange/mid-

woofer at the top of a tall loudspeaker, the 

 

front spike might chatter on a hard surface due 

to the up and down forces generated. 

How about a woofer at the bottom of the 

loudspeaker cabinet?  

Looking at the forces created by a woofer at the 

bottom of the speaker, the forces on the spikes 

are primarily horizontal. However, as the woofer 

produces very much larger forces than the 

midrange and it is usually mounted at the 

bottom, most of the vibrational forces in a 

loudspeaker are horizontal – the plane on which 

a spike is least effective as a coupler. This is 

also true of the forces on a bookshelf 

loudspeaker on the top of a loudspeaker stand. 

A pair of spiked loudspeakers on a very low 

friction surface (steel spike on a diamond 

surface for example) might well be launched 

backwards with a single very loud drum kick. 

With sufficient friction on the other hand, the 

forces around the moment of the front and rear 

spike will generate vertical forces in the other 

spike – resulting in the subwoofer rocking on 

the spikes and hopping around the room. 

Effectiveness of Spikes 

When a loudspeaker is sufficiently massive, the 

spike is an effective coupler. The large static 

forces in the vertical plane are difficult to be 

overcome by the vibrational forces in the 
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horizontal plane. However, it may not be 

efficient enough as a coupler to sink the 

vibrations generated by the drivers to the 

earth depending on the scale of difference. 

As a result, most spiked loudspeakers will 

sound different depending on the surface 

upon which they are placed. It may sound 

“harsh and brittle” if the spike is just barely 

scratching the surface of a stone or tile floor, 

or “warm and inviting” if the spike has nailed 

the loudspeaker into a wooden suspended 

floor that is now booming along with the 

loudspeaker. 

Band-Aids for Spiked Loudspeakers 

Enter the “spike cup”. 

For many reasons, including to protect a 

valuable hardwood floor, and to “improve” the 

sound of a spiked loudspeaker, the spike cup 

was invented. 

With stone and ceramic floors, the spike cup 

(usually made of a metal) solved the problem 

of a hard, scratchy sound caused by the spike 

scratching the surface of the stone, or a warm, 

muddy sound when the floor is made of wood. 

A cup is also often used to protect a hardwood 

floor from being marked by the sharp spike. 

Remembering that there are more vibration 

forces in the horizontal plane due to driver 

 
A spike cup may 

increase horizontal 
coupling due to 

friction. 

 
But a copper penny 

may work even better 

and is likely cheaper! 

movement in the loudspeaker, and due to the 

mass of the loudspeaker, there are more static 

forces in the vertical plane, the cup couples well 

vertically to the earth, and friction between the 

cup and the surface helps couple to dissipate 

horizontal vibration forces. 

When the cup is made of soft metal like copper or 

bronze, a steel spike deforms the surface and 

then couples the spike better to the cup. Due to 

the much larger contact area between the cup and 

the ground, vertical coupling is not as good, but 

since most of the vertical forces are static, the 

degree of coupling is not critical. 

A soft metal is also likely to have higher friction 

against a smooth floor like granite or marble. An 

excellent substitute for a spike cup is a pre-1982 

US penny. We use a pre-1982 penny because they 

were 95% copper, whereas post-1982 pennies 

were zinc with a thin copper plating. For whatever 

reason, we find copper pennies to sound far 

better than zinc pennies (and most spike cups we 

have encountered.) 

If you have pre-1964 US dimes in your pocket, 

they are even better than pre-1983 pennies as 

they are made of silver, silver being softer than 

copper. 

Due to the weight of the loudspeaker, the spike is 

likely to put a dimple on one side of the coin, and 

push out a nipple on the other side. This serves to 

better couple the spike to the coin in the 

horizontal plane, and also better couple the coin 

to the floor. 

Hence, coupling or spiking a loudspeaker is not 

straightforward. 

In the next issue, we will examine decoupling 

using various elastic and visco-elastic materials 

and the innovative Genesis loudspeaker acoustic 

suspension system. 
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The Polish magazine High Fidelity conferred upon the Genesis 

7.1f loudspeaker their Best Product 2011 award. While they were 

reviewing the speaker, we launched the new G7.2f with improved 

crossover, tweeter, midrange and servo-control feedback. 

We are now looking forward to getting the G7.2f to the same 

reviewer, and hoping that the latest version will get the Best of 

2012 award!! 

Cheers! 
Gary 

A Year-end Award 

 

 

 
 
 

 
 

 
 
 
 
 
 
 

 
 
 

 

 
 

 
 

 

 


